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ETAS Introduction
1 Introduction

ASCET-DIFF is a program that compares two ASCET models. This allows you to
compare, e.g., two development states, and produces clear results in a short
time. 

The comparison results are displayed in various tabs; different colors are used to
distinguish between identical and changed elements, as well as elements occur-
ring in only one component. Details are given in the ASCET-DIFF online help.

With ASCET-DIFF V6.4, the following types of ASCET components can be com-
pared:

• block diagram classes/modules, 

• AUTOSAR software components, 

• AUTOSAR interfaces 

• AUTOSAR mode groups

• state machines

• ESDL and C code components

• enumerations

• records

• containers 

• projects

1.1 Safety Advice

Please adhere to the Product Liability Disclaimer (ETAS Safety Advice) and to the
following safety instructions to avoid injury to yourself and others as well as dam-
age to the device.

1.1.1 Correct Use

ETAS GmbH cannot be made liable for damage which is caused by incorrect use
and not adhering to the safety instructions.

1.1.2 Labeling of Safety Instructions

The safety instructions contained in this manual are shown with the standard
danger symbol shown below:

The following safety instructions are used. They provide extremely important
information. Read this information carefully.   

WARNING

Indicates a possible medium-risk danger which could lead to serious or even 
fatal injuries if not avoided.
ASCET-DIFF V6.4 - Installation Guide 5
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1.1.3 Demands on the Technical State of the Product

The following special requirements are made to ensure safe operation:

• Take all information on environmental conditions into consideration 
before setup and operation (see the documentation of your computer, 
hardware, etc.).

Further safety advice is given in the ASCET V6.4 safety manual (ASCET Safety
Manual.pdf) available at ETAS upon request. 

1.2 User Profile

ASCET-DIFF users should be familiar with the Microsoft Windows® operating sys-
tems. All users should be capable of executing menu functions, activating but-
tons etc. Users should also be acquainted with the Windows file storage system,
particularly the relations between files and directories. The user must know
about and have mastered the basic functions of the Windows File and Program
Manager and Windows Explorer. The user should also be familiar with "Drag &
Drop".

All users who are not familiar with the basic techniques of Microsoft Windows
should familiarize themselves with them before using ASCET-DIFF. Details of
working with Windows are contained in the relevant manuals by Microsoft Cor-
poration.

Knowledge of ASCET is required. 

1.3 Structure of the Documentation

The ASCET-DIFF documentation consists of the following parts:

• this installation guide

• an online help

The ASCET-DIFF Installation Guide consists of the following chapters:

• "Introduction" on page 5 (this chapter) 

This is where you are given an initial overview of the possible field of appli-
cation of ASCET-DIFF. It also contains  general information such as tips 
and system information.

CAUTION

Indicates a low-risk danger which could result in minor or less serious injury or 
damage if not avoided.

NOTICE
Indicates behavior which could result in damage to property.
ASCET-DIFF V6.4 - Installation Guide
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• "Installation" on page 9

This chapter is intended for all users who install, maintain and uninstall 
ASCET-DIFF. It provides important information on the delivery scope, 
hardware and software requirements. The sequence of both the installa-
tion and uninstallation of ASCET-DIFF is also described.

• "Licensing the Software" on page 22

This chapter contains various licensing information.

• "Starting ASCET-DIFF" on page 23

This chapter explains how to start ASCET-DIFF both as standalone tool and 
as ASCET add-on.

• "Starting ASCET-DIFF Model Viewer" on page 28

This chapter explains how to start the ASCET-DIFF Model Viewer via the 
command line or the context menu in the windows file explorer.

• "ETAS Contact Addresses" on page 32

This chapter contains the contact addresses of the ETAS subsidiaries.

1.4 ASCET-DIFF Online Help – Quick Guide

Use the Help → Help Contents menu option to invoke the online help. 

The panes of the help window provide you with the following information:

• The left pane shows the table of content, index, search results, links or 
bookmarks.

• The right pane contains the current help topic. 

The first topic displayed here contains a short description of ASCET-DIFF. 
Click on the TOC entry in the left pane to open the more detailed 
ASCET-DIFF overview topic.
ASCET-DIFF V6.4 - Installation Guide 7
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1.5 Conventions

Documentation Conventions

All activities executed by the user are displayed in a "use case" format, as shown
by the following example. A task in this manual is a sequence of actions which
have to be executed to attain a specific goal. The title of the task  usually specifies
the result of the actions, e.g. "To create a new component" or "To rename an
element". 

To attain a goal:

Any introductory information...

• Execute action 1.

• Explanations are listed under an action.

• Execute action 2.

Any explanation of step 2...

• Execute action 3.

Any explanation of step 3...

Any concluding remarks...

Typographic Conventions

The following typographic conventions are used:

Important notes for the user are shown as follows:

Select File → Open. Menu options are shown in boldface/blue.

Click OK. Buttons are shown in boldface/blue.

Press <ENTER>. Keyboard commands are shown in angled 
brackets, in block capitals.

The "Open File" dialog window 
opens.

Names of program windows, dialog windows,  
fields etc. are shown in quotation marks.

Select the file setup.exe. Text in drop-down lists on the screen, pro-
gram code, as well as path and file names are 
shown in the Courier font.

A distribution is a one-dimen-
sional table of sample points.

Content markings and newly introduced 
terms are shown in italics.

The OSEK group (see 
http://www.osek-vdx.org/) has 
developed certain standards.

Links to internet documents are set in blue, 
underlined font.

Tip

Important note for the user.
ASCET-DIFF V6.4 - Installation Guide
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2 Installation

This chapter is intended for all users who install, maintain and uninstall
ASCET-DIFF on a PC. It provides information on the delivery scope, hardware and
software requirements as well as on how to prepare the installation (section 2.1).
The sequence of both installation (section 2.2) and uninstallation (section 2.5) of
ASCET-DIFF is described; command line installation/uninstallation (section 2.3)
and setting the licensing behavior (section 2.4) are explained as well.

2.1 Preparations

Check the delivery package to make sure it is complete and make sure your sys-
tem corresponds to the system requirements. Make sure that you have the nec-
essary user privileges.

2.1.1 Delivery Scope

The delivery scope of ASCET-DIFF includes:

• ASCET-DIFF program files

• ASCET-DIFF Installation Guide in PDF format (Adobe Reader)

2.1.2 ASCET-DIFF License

You require a valid license for ASCET-DIFF if you want to use the tool. You obtain
the license file required for licensing either from your tool coordinator or through
a self-service portal on the ETAS internet site at http://www.etas.com/support/
licensing. To request the license file you have to enter the activation number
which you received from ETAS during the ordering process. 

For further information on licensing, see "Licensing the Software" on
page 22.

2.1.3 System Prerequisites

ASCET-DIFF requires the same system prerequisites as ASCET. 

2.1.4 Required User Privileges for Installation and Operation

User Privileges Required for Installation::

In order to install ASCET-DIFF on a PC, you need the user privileges of an admin-
istrator.

If the user name under which you have registered in Windows does not have
administrator privileges, a warning message is displayed and the ASCET-DIFF
installation is canceled. In that case, please contact your system administrator.

User Privileges Required for operation:

The operation of ASCET-DIFF requires the same user privileges as ASCET.

2.2 Installation

You can install ASCET-DIFF as standalone tool, as add-on to ASCET, or both. You
can, however, only install the add-on variant of ASCET-DIFF if ASCET has already
been installed on your computer.
ASCET-DIFF V6.4 - Installation Guide 9
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The installation is independent of whether you install ASCET-DIFF from installa-
tion disk or a network drive. 

Windows® 7 (32 bit or 64 bit), Windows® 8, Windows® 8.1, or Windows® 10
(64 bit in 32 bit compatibility mode) is required to install ASCET-DIFF.

To start the ASCET-DIFF installation:

• Insert the installation disk in the respective drive on 
your PC. 

• Select the drive in the Windows Explorer and run 
the Setup.exe file.

The ETAS Installer is launched. 

• Click Next to continue.

The installer checks if your computer meets the sys-
tem requirements for ASCET-DIFF installation. The 
result is displayed in the "System Check" window.

If your system meets the installation requirements, 
the installer proceeds automatically to the next win-
dow.

If your system does not meet the system require-
ments, follow the instructions in the "System 
Check" window and re-start the installation.
ASCET-DIFF V6.4 - Installation Guide
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To accept the license agreement:

The following window shows the license agreement. 

• Read the license agreement, then activate the 
I read and accept the license agreement option.

If you do not accept the license agreement, you 
cannot continue the installation.

• Click Next to continue.

Or

• Click Proceed to Install to go to the "Ready to 
install" window immediately, with default settings 
for components to be installed, installation and 
workspace paths, etc.

Continue reading in section "To install 
ASCET-DIFF:" on page 15.

To select the installation type:

The "Installation Type" window allows you to select either a standard installation
or a side-by-side installation. The following installation type options are available:

• Standard Installation: ASCET-DIFF V6.4.x is installed as ASCET-DIFF 
V6.4. Previous installations of ASCET-DIFF V6.4.* are uninstalled automat-
ically.
ASCET-DIFF V6.4 - Installation Guide 11
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• Side-by-Side Installation: ASCET-DIFF V6.4.x is installed as ASCET-DIFF 
V6.4.x. Previous installations of ASCET-DIFF V6.4.y are kept, except for 
y = x.

• Read the explanations in the "Installation Type" 
window.

• Activate the option for the installation type you 
want to use.

• Click Next to continue.

Or

• Click Proceed to Install to go to the "Ready to 
install" window immediately, with default settings 
for installation and workspace paths, etc.

Continue reading in section "To install 
ASCET-DIFF:" on page 15.
ASCET-DIFF V6.4 - Installation Guide
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To define path settings:

In the "Installation Path" window, you are prompted to enter a destination direc-
tory for the installation (referred to as <installation>).

• To change a preset directory, enter or select (via the 
Browse button) the new path.

If you entered an invalid path, the Next and Pro-
ceed to Install buttons are disabled.

• If you used the Browse button, proceed as follows.

– In the "Browse For Folder" window, select an 
existing directory.

Or

– Use the tree structure and the Make New 
Folder button to create a new folder.

– Click OK to close the "Browse for Folder" win-
dow and accept your selection.
ASCET-DIFF V6.4 - Installation Guide 13
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• Click Next to continue.

Or

• Click Proceed to Install to go to the "Ready to 
install" window immediately, with default settings 
for workspace path, etc.

Continue reading in section "To install 
ASCET-DIFF:" on page 15.

• In the "Workspace Path" window, enter or select a 
path for the ASCET-DIFF workspace.

• Click Next to continue.

Or

• Click Proceed to Install to go to the "Ready to 
install" window immediately, with default settings.

Continue reading in section "To install 
ASCET-DIFF:" on page 15.

To associate with ASCET:

The "Associate ASCET-DIFF with ASCET version(s)" window lists all installations
lower than ASCET V6.1.0 on your PC.

Tip

This instruction is only relevant if one or more ASCET versions lower than 
V6.1.0 are installed on your PC.
ASCET-DIFF V6.4 - Installation Guide
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• Select the ASCET installation(s) you want to use 
with ASCET-DIFF.

ASCET-DIFF cannot be started from within ASCET 
installations not selected.

• Click Next or Proceed to Install to continue.

To install ASCET-DIFF:

The "Ready to install" window lists the components selected for installation.  

• In the "Ready to install" window, click Install.

ASCET-DIFF and the prerequisites are installed. 
Components already present on your PC are 
skipped. A progress indicator shows how the instal-
lation is progressing.

To complete the installation:

Once all components have been installed successfully, you are prompted to end
the installation. 

• Click on Finish to end the installation.

Tip

The next step will start the installation. You cannot 
cancel the installation once it is running; the Cancel 
button is deactivated.
ASCET-DIFF V6.4 - Installation Guide 15
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An icon is placed on the desktop of your PC, and the ASCET-DIFF folder with
the following entries is created in the Windows Start menu:

The version number shown in desktop icon and start menu entries depends on
the installation type (standard: Vx.y or side-by-side: Vx.y.z) you selected (see
page 11).

• ASCET-DIFF Vx.y[.z]

The ASCET-DIFF program is started.

• ReadMe

Opens the Readme file.

The ETAS License Manager has its own folder, License Management, in the
ETAS program group of the Windows Start menu. This folder contains a single
entry, ETAS License Manager.

2.3 Command Line Installation / Uninstallation

When you start the ASCET-DIFF installation from a command line, you can use
several command-line parameters to customize the installation.

Each execution of Setup.exe writes a log file %appdata%1\ETAS\SETUP\
<date_time> Setup.log.

/silent

Silent installation mode. With this installation mode, no dialog windows 
requiring user information open. 

Default values are used for all information normally requested in installa-
tion windows. Error messages are hidden, too.

/EULAAccepted

Accepts the license agreement. 

The text of the license agreement is provided on the installation disk, in 
the EULA subfolders. 

1. %appdata% = 
C:\Users\<username>\AppData\Roaming (Windows 7)

Tip

To accept EULA (cf. page 11) during silent installation, you must use the 
command-line parameter /EULAAccepted.
To deal with a possible request for a computer restart, you must use 
either the /NoRestart or the /AllowRestart command line 
parameter.
ASCET-DIFF V6.4 - Installation Guide
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/NoRestart

Suppresses a computer restart that may be required at the end of the 
installation. If a reboot is suppressed, a log message is issued.

/AllowRestart

Allows a computer reboot restart that may be required at the end of the 
installation. A restart is performed without further notice.

/Debug

Writes additional log files for *.msi packages. 

These files are stored in the %appdata%1\ETAS\SETUP folder.

/DefaultSettings

Allows to specify an own XML file with default settings (instead of using 
InstallationDefaultSettings.xml). 

You can specify a relative path if the file is relative to Setup.exe, other-
wise you have to specify a absolute path.

Syntax: /DefaultSettings:"<path>\<filename>.xml"

/uninstall

Uninstalls ASCET-DIFF. Can be combined with /silent for uninstallation 
without user interaction.

Examples:

Setup.exe /silent /EULAAccepted 

Triggers a silent installation. 

Setup.exe /uninstall /Debug

Triggers an uninstallation and writes additional logs.

Setup.exe /DefaultSettings:"D:\myOwnSettings.xml"

Triggers a non-silent installation that uses your own default settings for 
the installation.

By default, silent installation uses the standard installation type (see page 11). To
select side-by-side installation, proceed as follows:

To select Side-by-Side for command-line installation:

• Copy the InstallationDefaultSet-
tings.xml file to a location where you can edit it.

• Open InstallationDefaultSettings.xml 
in a suitable editor.

1. %appdata% = 
C:\Users\<username>\AppData\Roaming (Windows 7)

Tip

For command-line uninstallation, you must run setup.exe from the follow-
ing location:

ETAS\GENericSetup\ASCET_DIFF ASCET-DIFF\<a>.<b>.<c>.<d> 
in your program directory
ASCET-DIFF V6.4 - Installation Guide 17



18

Installation ETAS 
• In the editor, go to the package with 
ID="ASCET_DIFF ASCET-DIFFInstall-
Pack_<a>.<b>.<c>.<d>".

• In that package, edit the variable 
PRODUCT_FOLDER_VERSION as follows:

<Variable
name="PRODUCT_FOLDER_VERSION"
defaultValue="[packagevar:xyzversion]"
validation="none" />

packagevar:xyzversion is required for side-
by-side installation.
packagevar:xyversion is required for stan-
dard installation.

• Save the XML file.

• Use /DefaultSettings (cf. page 17) to pass 
the changed InstallationDefaultSet-
tings.xml file to the command-line installation. 

2.4 Setting the Licensing Behavior

The ASCET-DIFF installation includes an installation of the ETAS license manager.
You can define the way in which ASCET-DIFF (and other ETAS software pro-
grams) access the required licenses in the [Licensing] section of an *.ini
file.

Such an *.ini file is available on your installation disk, in the ...\Packages\
ASCET-DIFF LicensingASCET-DIFFInstallPack_6.4.<x>.<y>
folder. You can copy this file to a local directory and adapt it according to your
needs.

To define the access to the required licenses:

• Open the *.ini file with a text editor.

• Modify the settings in the [Licensing] section 
as desired. 

The parameters and their settings are described 
below.

• Save your changes.

The following parameters may be used:

• LicenseFileName

Defines the absolute path to the location of the license file which is to be 
added.

• LicensesToBorrow

You can use this setting if licenses can be borrowed from a license server. 
To enable the borrow mechanism, you must enter the name of the prod-
uct or features license (e.g. ASCET-DIFF). If you enter more than one 
license, the license names must be separated by blanks.
ASCET-DIFF V6.4 - Installation Guide
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• BorrowExpiryMode

Defines the way in which the expiration of the borrow status is given. 
Possible values are:

– Date

If the BorrowExpiryMode is set to Date, the borrow period will 
expire at a certain date which is specified under BorrowExpiry-
Date.

– Interval

If the BorrowExpiryMode is set to Interval, the borrow period 
will expire after a certain number of days which is specified under 
BorrowExpiryInterval.

• BorrowExpiryDate

If the BorrowExpiryMode is set to Date, this parameter specifies the 
date when the borrow period expires. The format is yyyy-mm-dd.

• BorrowExpiryInterval

If the BorrowExpiryMode is set to Interval, this parameter specifies 
the length of the borrow period in days.

• ExecuteBorrowAutomaticExtensionInterval

Defines at what point of time the borrow period will be automatically 
extended. This parameter specifies the number of days before the expira-
tion of the current borrow period. When this time is reached, the borrow 
period is automatically extended to the interval specified under 
BorrowAutomaticExtensionInterval.

• BorrowAutomaticExtensionInterval

This parameter specifies the borrow interval in days that is applied when 
an automatic extension of the borrow period is executed (as defined 
under ExecuteBorrowAutomaticExtensionInterval).

• ImmediateBorrow

You can define that a license is automatically borrowed. Possible values 
are:

– True

The license is borrowed automatically at installation time.

– False

The license will be borrowed at the first time when the program con-
nects to the license server.

Tip

ImmediateBorrow=’True’ works only for the user who per-
forms the installation. Other users who work on the same computer 
do not own the borrowed license.
ASCET-DIFF V6.4 - Installation Guide 19
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• CustomLicenseFolder

Due to the fact that the default location for added license files (e.g., 
C:\ProgramData\ETAS\FlexNet for Windows 7) is only writable for 
users with admin rights, a different path for the license file folder may be 
specified with this parameter.

The following example defines that borrowing is enabled for ASCET-DIFF. The
license will be borrowed when ASCET-DIFF is started for the first time; by default
the license expires after 100 days.

[Licensing]

LicenseFileName = ’d:\licenses\MyLicense.lic’

LicensesToBorrow = ’ASCET-DIFF’

BorrowExpiryMode = ’Interval’

BorrowExpiryInterval = ’100’

ImmediateBorrow = ’false’

2.5 Uninstallation

If you uninstall ASCET-DIFF, all installed variants are uninstalled automatically. 

To uninstall ASCET-DIFF:

• Start the uninstall procedure via the Programs and 
Features icon in the Windows Control Panel.

The ETAS installer is launched.

You can use the Next button to get to the next 
uninstallation window; Back to get to the previous 
window, and Cancel to cancel uninstallation.
ASCET-DIFF V6.4 - Installation Guide
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• Click Next to check if your computer meets the sys-
tem requirements for ASCET-DIFF uninstallation.

The result is shown in the "System Check" window.

• Click Next to continue.

The "Ready to uninstall" window opens. It lists the 
components that will be uninstalled. You cannot 
change the selection. 

• Click Uninstall to actually uninstall ASCET-DIFF.

A progress indicator shows how the uninstallation 
is progressing.

Once all components have been uninstalled, a suc-
cess window opens.

• Click Finish to end the uninstallation.

Tip

The next step will start the uninstallation. You cannot cancel uninstallation 
once it is running; the Cancel button is deactivated.
ASCET-DIFF V6.4 - Installation Guide 21
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3 Licensing the Software

A valid license is required to use ASCET-DIFF. You can obtain the license file
required for licensing either from your tool coordinator or through a self-service
portal on the ETAS internet site under http://www.etas.com/support/licensing.
To request the license file you have to enter the activation number which you
received from ETAS during the ordering process.

In the Windows Start menu, select Programs → ETAS →  License
Management → ETAS License Manager.

Follow the instructions given in the dialog. For further information about, for
example, the ETAS license models, or borrowing a license, press <F1> in the
ETAS License Manager.

http://www.etas.com/support/licensing
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4 Starting ASCET-DIFF

Depending on the way ASCET-DIFF is installed, you can start it individually or as
add-on from within ASCET.

4.1 Starting the Standalone Variant

To start the standalone variant:

• In the Windows Start menu, go to the ETAS pro-
gram group and select ASCET-DIFF 6.4 → 
ASCET-DIFF V6.4.

Or

• Double-click the ASCET-DIFF desktop icon.

ASCET-DIFF starts. 

If no valid license file is detected, a grace mode is 
activated. That is a limited period of time during 
which the tool is fully operational, but a license file 
is searched regularly, and a warning is issued when 
the search fails. See also chapter 3 "Licensing the 
Software".

If you start ASCET-DIFF for the first time, the "Wel-
come to ASCET-DIFF" window opens.

• Click on the Start ASCET-DIFF link.

ASCET-DIFF opens.
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4.2 Starting the Add-On Variant

Add-On to ASCET V6.0 or Lower

If ASCET-DIFF is installed as add-on to ASCET V6.0 or lower, the Compare menu
with the following menu items is added to the ASCET component manager.

• Open ASCET-DIFF 

Opens ASCET-DIFF.

• Compare selected components 

Compares two selected components.

• Compare selected components recursively 

Compares two selected components and their included components.

If ASCET-DIFF is installed as add-on to ASCET V6.0 or lower, and if ASCET-SCM
is installed on your PC, ASCET-DIFF is made known to ASCET-SCM during instal-
lation.

Add-On to ASCET V6.1 or Higher

If ASCET-DIFF is installed as add-on to ASCET V6.1 or higher, you have to per-
form the following steps before you can use ASCET-DIFF within ASCET and—if
installed—ASCET-SCM.

To set up ASCET-DIFF usage in ASCET V6.1 or higher:

• Open the ASCET component manager.

• In the component manager, select Tools → 
Options.

The ASCET options window opens.

• In the options window, go to the "ASCET-DIFF" 
node.

The nodes have been re-structured in ASCET V6.2.

≤ V6.1
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• Select the ASCET-DIFF version you want to use with 
ASCET V6.1 or higher.

• Click Ok to close the ASCET options window.

With that, the ASCET-DIFF submenu is added to the Tools menu in the ASCET
component manager.

The Compare submenu is also available as context menu in the "1 Database" or
"1 Workspace" list.

Add-On to any ASCET Version

To start ASCET-DIFF from within ASCET: 

If the add-on variant of ASCET-DIFF is installed, you can access ASCET-DIFF via
the ASCET component manager.

• Open the ASCET component manager.

Tip

With ASCET V6.1 or later, you have to set up ASCET-DIFF usage first, see 
page 24

≥ V6.2
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• In the "1 Database" or "1 Workspace" field, select 
two components you want to compare.

1. ASCET V6.1 or later

• Do one of the following:

– Select Tools → ASCET-DIFF → Open 
ASCET-DIFF to start the tool without compar-
ing the components.

– Open the components’ context menu and 
select Compare → Selected Components or 
Selected Components Recursively.

– Select Tools → ASCET-DIFF → Compare → 
Selected Components or Selected Compo-
nents Recursively.

2. ASCET V6.0 or earlier

• Do one of the following:

– Select Compare → Open ASCET-DIFF to start 
the tool without comparing the components.

– Select Compare → Selected Components or 
Selected Components Recursively.

3. all

Selected Components compares only the selected 
components.

Selected Components Recursively compares the 
selected components and the referenced compo-
nents.

The comparison is executed. ASCET-DIFF opens and 
displays the results.

4.3 Starting ASCET-DIFF via the Command Line

You can start ASCET-DIFF via the command line, too. Use the following syntax:

ASCET-DIFF "<left main file>" "<right main file>"

<left main file> and <right main file> are path and file name
(including extensions) of the *.main.amd files of the components you want to
compare.

ASCET-DIFF can be invoked from the command line in two different configura-
tions:

• With switches

• Without switches

With switches: ASCET-DIFF can be invoked from the command line with
switches using the following syntax:

ASCET-DIFF -lf "<left file path>" -rf "<right file 
path>" -lc "<left component name>" -rc "<right compo-
nent name>" -lv "<left version string>" -rv "<right 
version string>" 
ASCET-DIFF V6.4 - Installation Guide
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where

• -lf is the left file path switch

• -rf is the right file path switch

• -lc is the left component name switch (optional)

• -rc is the right component name switch (optional)

• -lv is the left version string switch (optional)

• -rv is the right version string switch (optional)

The switches -lf and -rf are mandatory.

The same command line switches can also be used to specify compressed files
(originally in AXL or ZIP format) having renamed file names. The file extensions
can also be arbitrary, however, the component names have to be specified as
arguments.

Without switches: ASCET-DIFF can also be invoked from the command line
without switches. In that case, the first argument is assumed to be absolute path
of the left component and the second argument is assumed to be absolute path
of the right component. The following command line syntaxes are supported:

1. ASCET-DIFF "<left file path>" "<right file path> "

2. ASCET-DIFF "<left file path>" "<right file path>" 
"<relative path of left component>" "<relative path 
of right component> "

3. ASCET-DIFF "<left file path>" "<right file path>" 
"<relative path of left component>" "<relative path 
of right component>" "<timestamp>" 

This syntax is used for interfacing ASCET-DIFF to ASCET.

4. ASCET-DIFF "<left file path>" "<right file path>" 
"<left component name>" "<right component name> "

This syntax can be used when left and right archive files have been 
renamed or have multiple components and the component names are 
passed as argument.
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5 Starting ASCET-DIFF Model Viewer

The following chapters will describe how to start ASCET-DIFF in the model viewer
mode using a command line prompt or the Windows context menu. It can be
invoked from the command line with relative or absolute path specification.

• "Starting the Command Prompt" on page 28

• "Command Line arguments for invoking the Model Viewer" on page 29

• "Starting ASCET-DIFF Model Viewer via Context Menu" on page 31

5.1 Starting the Command Prompt 

The installation directory of ASCET-DIFF is the starting point within the Com-
mand Prompt window. Usually this is the following path:

C:\Program Files (x86)\ETAS\ASCET-DIFF6.4.0

Then a distinction is made between the argument for relative and absolute path.
How to invoke the Model Viewer using an absolute path specification is
described in the following chapter. First, you must start the command prompt.

To start the command prompt and change directory to installation direc-
tory

• In the Windows Start menu, go to the Accessories 
program group and select Command Prompt.

Or

• In the Windows Start menu, enter "cmd" in the 
"Search programs and files" field and press 
<ENTER>.

The "Command Prompt" window opens.

Tip

You can only start the ASCET-DIFF Model Viewer if you have the required 
"ASCET-VIEW" license. Note that no Grace Mode is available for the ASCETDIFF 
Model Viewer. For more information on existing licenses, see chapter "Licens-
ing the Software" on page 22 or contact your system administrator. 
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• In the "Command Prompt" window, enter the syn-
tax for changing to the installation directory. 

If you used the default path for the 32-bit installa-
tion, use the following exemplified syntax:

cd C:\Program Files 
(x86)\ETAS\ASCET-DIFF6.4.0

If you used the default path for the 64-bit installa-
tion, use the following exemplified syntax:

cd C:\Program Files\ETAS\ASCET-
DIFF6.4.0

You are now in the installation directory of 
ASCET-DIFF V6.4.

5.2 Command Line arguments for invoking the Model Viewer

This chapter describes how to invoke the ASCET-DIFF Model Viewer using an
absolute path specification for a component within the command line prompt.
Prerequisite is that you have already changed in the ASCET-DIFF installation
directory (see chapter 5.1 on page 28).

To specify the command line argument 

• In the "Command Prompt" window, enter the fol-
lowing syntax:

ASCET-DIFF.exe -f "<path>\<file 
name>.<format>" -c <component name> 
-v <version>

where

– ASCET-DIFF.exe is the argument to start 
ASCET-DIFF.

Tip

Specifying the syntax for changing to the installation 
directory may vary and depends on where you 
installed the system. For more information on how to 
install ASCET-DIFF V6.4, see chapter 2.2.

Tip

Only files with the file extension *.main.amd or *.axl will be displayed in the 
ASCET-DIFF Model Viewer.
ASCET-DIFF V6.4 - Installation Guide 29



30

Starting ASCET-DIFF Model Viewer ETAS 
– -f "<path>\<file name>.<format>" is 
the file path switch. The path of the component 
can be specified absolute or relative to the 
installation directory.

Relative:

(-f)"..\ASCET-DIFF 6.4\Sam-
ples\<file name>.<format>"

Absolute:

(-f)"C:\Program Files 
(x86)\ETAS\ASCET-DIFF 6.4\Sam-
ples\<file name>.<format>"

– -c <component name> is the component 
name switch (optional).

– -v <version> is the version string switch 
(optional).

The following graphic shows the command prompt 
window including an exemplary command line 
argument:

• Press <ENTER>.

The command will be executed and ASCET-DIFF will 
be invoked in the Model Viewer mode displaying 
the specified component.

Tip

The specification of the key "-f" prior the path is 
optional only if no other key is used in the command 
line argument.

Tip

The specification of the component name key "-c" is 
not necessary for axl files (*.axl) if the file contains 
only one component with the same name.
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5.3 Starting ASCET-DIFF Model Viewer via Context Menu

This chapter describes how to invoke the ASCET-DIFF Model Viewer using the
Windows context menu.

To start the Model Viewer via context menu

• In the Windows file explorer, right-click on the 
*.main.amd file you want to view.

The respective context menu opens.

• Click on Open with.

The "Open with" window opens.

• Select ASCET-DIFF.exe to open this file.

• Click OK.

ASCET-DIFF V6.4 starts in the model viewer mode. 

Tip

With the checkbox "Always use the selected program 
to open this kind of file" you can set the selected pro-
gram as default. Once you have set the default pro-
gram, you can start the ASCET-DIFF Model Viewer 
directly over the entry View in ASCET-DIFF V6.4.0 
in the windows context menu.
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6 ETAS Contact Addresses

ETAS HQ

ETAS GmbH

ETAS Subsidiaries and Technical Support

For details of your local sales office as well as your local technical support team
and product hotlines, take a look at the ETAS website:

Borsigstraße 14 Phone: +49 711 3423-0

70469 Stuttgart Fax: +49 711 3423-2106

Germany WWW: www.etas.com

ETAS subsidiaries WWW: www.etas.com/en/contact.php

ETAS technical support WWW: www.etas.com/en/hotlines.php

http://www.etasgroup.com
http://www.etasgroup.com
http://www.etasgroup.com
http://www.etas.com
http://www.etas.com/en/contact.php
http://www.etas.com/en/hotlines.php


ETAS Index
Index

A
add-on to ASCET

ASCET V6.0 or lower 24
ASCET V6.1 or higher 24
enable usage (ASCET V6.1 or 

higher) 24
install 14
start 25

ASCET-DIFF
and ASCET-SCM 24
associate with ASCET 14
enable usage (ASCET V6.1 or 

higher) 24
install 9
path specification 13
select installation type 11
start from ASCET 25
start from command line 26
start installation 10
start standalone variant 23
uninstall 17, 20
workspace path specification 14

C
command line

installation 16
side-by-side 17
silent installation 16
start ASCET-DIFF 26
uninstallation 17

E
ETAS Contact Addresses 32

G
grace mode 23

I
Installation

ASCET-DIFF 9
associate with ASCET 14
command line 16
command line + side-by-side 17
license agreement 11
path specification 13
select type 11
set licensing behavior 18
silent 16
start 10
system prerequisites 9
uninstall ASCET-DIFF 20
without administrator privileges 9
workspace path specification 14

L
Licensing 22

grace mode 23
set behavior 18

P
Product liability disclaimer 5
ASCET-DIFF V6.4 - Installation Guide 33



34

Index ETAS
S
Safety Instructions

technical state 6
silent installation 16
standalone variant 16

start 23

U
uninstallation 17, 20
ASCET-DIFF V6.4 - Installation Guide


	ASCET-DIFF V6.4
	1 Introduction
	1.1 Safety Advice
	1.1.1 Correct Use
	1.1.2 Labeling of Safety Instructions
	1.1.3 Demands on the Technical State of the Product

	1.2 User Profile
	1.3 Structure of the Documentation
	1.4 ASCET-DIFF Online Help – Quick Guide
	1.5 Conventions

	2 Installation
	2.1 Preparations
	2.1.1 Delivery Scope
	2.1.2 ASCET-DIFF License
	2.1.3 System Prerequisites
	2.1.4 Required User Privileges for Installation and Operation

	2.2 Installation
	2.3 Command Line Installation / Uninstallation
	2.4 Setting the Licensing Behavior
	2.5 Uninstallation

	3 Licensing the Software
	4 Starting ASCET-DIFF
	4.1 Starting the Standalone Variant
	4.2 Starting the Add-On Variant
	4.3 Starting ASCET-DIFF via the Command Line

	5 Starting ASCET-DIFF Model Viewer
	5.1 Starting the Command Prompt
	5.2 Command Line arguments for invoking the Model Viewer
	5.3 Starting ASCET-DIFF Model Viewer via Context Menu

	6 ETAS Contact Addresses
	Index



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.5
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo true
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts false
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue true
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
    /FrutigerLT-Black
    /FrutigerLT-BlackCn
    /FrutigerLT-BlackItalic
    /FrutigerLT-Bold
    /FrutigerLT-BoldCn
    /FrutigerLT-BoldItalic
    /FrutigerLT-Cn
    /FrutigerLT-ExtraBlackCn
    /FrutigerLT-Italic
    /FrutigerLT-Light
    /FrutigerLT-LightCn
    /FrutigerLT-LightItalic
    /FrutigerLT-Roman
    /FrutigerLT-UltraBlack
  ]
  /NeverEmbed [ true
    /CourierNewPS-BoldItalicMT
    /CourierNewPS-BoldMT
    /CourierNewPS-ItalicMT
    /CourierNewPSMT
    /SymbolMT
    /TimesNewRomanMT-ExtraBold
    /TimesNewRomanPS-BoldItalicMT
    /TimesNewRomanPS-BoldMT
    /TimesNewRomanPS-ItalicMT
    /TimesNewRomanPSMT
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 450
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 2.00000
  /EncodeMonoImages false
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<


    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e55464e1a65876863768467e5770b548c62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc666e901a554652d965874ef6768467e5770b548c52175370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /ESP <>
    /ETI <>
    /FRA <>



    /HUN <>
    /ITA (Utilizzare queste impostazioni per creare documenti Adobe PDF adatti per visualizzare e stampare documenti aziendali in modo affidabile. I documenti PDF creati possono essere aperti con Acrobat e Adobe Reader 6.0 e versioni successive.)
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020be44c988b2c8c2a40020bb38c11cb97c0020c548c815c801c73cb85c0020bcf4ace00020c778c1c4d558b2940020b3700020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200036002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken waarmee zakelijke documenten betrouwbaar kunnen worden weergegeven en afgedrukt. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 6.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>


    /SKY <>

    /SUO <>
    /SVE <>
    /TUR <>

    /DEU <>
    /ENU (Use these settings to create Adobe PDF documents suitable for reliable viewing and printing of business documents.  Created PDF documents can be opened with Acrobat and Adobe Reader 6.0 and later.)
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


